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I. INTRODUCTION

A. OVERVIEW

This Two-Dimensional Finite-Volume Hydrodynamic Model (FVHM)) was developed by
" J. D. Lin, M. W. Lefor, W. G. Liao, and K-J. Qiu of the Civil & Environmental Engineering
Department of The University of Connecticut, Storrs. It was designed as a comprehensive
system for modeling the hydrodynamics of tidal flows in salt marshes and other estuarine
systems, with particular emphasis on the ability to assess the effects of natural or man-
made changes in channel configurations and tidal marshes. It is easy to use, and the user
will recognize many functions common to Windows programs. This system runs under
current MS-DOS operating systems such as Windows 98 and Windows NT, and uses multi-
tasking to get the most out of available computer resources.

This is a User's Manual for FVHM only. Further details on the Finite-Volume
Hydrodynamic Model are included in the final technical report, part of the series issued by
the Joint Highway Research Advisory Council of the Transportation Institute, The
University of Connecticut, Box U-5202, 179 Middle Turnpike, Storrs, CT 06269-5202, (860)
486-5400. A companion Tutorial is also available for those unfamiliar with running models
of this type.

Atits core, FVHM includes the finite-volume hydrodynamic model, along with a pre- and
post-processor. FVHM was especially designed to deal with complicated two-dimensional
(2-D) shallow-water problems met with in estuaries, such as salt marshes with complex
boundaries, hydraulic structures, mosquito drainage ditches, and frequent wetting and
drying cycles. Running FVHM will give hydrodynamic solutions including water surface
elevations, flow velocities, and wetting and drying cycles under diurnal tidal forcing and
storm surge conditions.

The pre- and post- processors provide a user-friendly interface for FVHM. They allow the
user to create realistic finite-volume meshes and to view the solutions in a simple and
intuitive environment.



B. FVHM APPLICATIONS

FVHM was designed to provide a way to analyze and study 2-D hydrodynamic data from
environmental problems in complicated waters, such as rivers, salt marshes, harbors, and
estuaries.

The model has the following capabilities:

1. handling complex topography, such as complex boundaries, multiple slough
inflows, and ditches;

2. simulating both subcritical and supercritical flows;

3. calculating steady or unsteady flows, such as tidal flows and storm surges;
4. simulating smooth and discontinuous flows;

5. handling wetting and drying cycles; and,

6. handling some simple hydraulic structures, such as bridges, culverts, and tide
gates.

C. SOFTWARE INSTALLATION

The model installation sequence consists of the installation of a number of compressed
files, estu.exe, model.dll, dialogs.dll, oscher.dll, utility.dll, estu.cnt, and estu.hlp. These
files are found on the model system diskette. Anumber of data files are also included there,
to be used by those taking the Tutorial. Correct installation requires that all these files be
unzipped into the same directory.

D. SYSTEM REQUIREMENTS

An Intel Pentium running at 200MHz or above (or an equivalent processor), running under
Windows NT 4.0 or Windows 95 or 98, is required to run the model. A Super VGA monitor
with maximum color setting is strongly recommended.



E. GETTING STARTED
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Figure 1.1. FVHM Main Window.

Double-clicking the ESTU.EXE icon will bring up the Main Window, as shown in Figure
1. 1. Please notify us if there is a problem with installation or with running the model. The
Workspace (the FVHM Main Window) is empty initially. You may either create a new
project, or open an existing project via the drop-down Menus or Toolbar.



II. MODELING PROCEDURE

Follow the steps given below to use FVHM for solving a 2-D, shallow-water hydrodynamic
problem.

A. IMPORTING THE OUTLINE OF THE MODEL DOMAIN

In a typical study, an outline data file for the site to be modeled is needed to define the
topography and the boundaries of the computational grid, and defines the model domain..
This outline file consists of a set of x, y, z coordinates, in ASCII format, and has the
extension .oln. Once the file is imported into FVHM, it may be displayed in the workspace
in the Main Window (see Fig. 1. 1) as an image of the model domain. You construct a
computational grid within this window. The coarseness or fineness of the grid you
construct depends on the amount of outline (survey) data you have, the precision of the
desired results, and the time it will take for the computer to run the model.

The outline data file can be generated by scanning a map of contour lines on a desktop
scanner. Frequently, however, a map of bathymetric contours showing channel sections
and geometry, etc., is not available. In that case, a field survey must be conducted to obtain
the required data for the outline files. The rule “GIGO” applies: the more complete and
accurate the input data, the more accurate the results.

B. CONSTRUCTING THE GRID

Next, you must construct a finite-volume grid. This grid discretizes the model domain into
cells, and describes the bathymetric contours (bottom surface geometry) of the body of
water to be modeled. Grid construction is done on-screen, intuitively, by using the FVHM
program. Topographic data in the form of x, y, z coordinates for each cell of the grid are
saved as an FVHM input file. Details of grid construction are described below in Section IV.



C. ASSIGNING MANNING’S COEFFICIENTS AND APPLYING BOUNDARY CONDITIONS

Once the grid has been constructed, the user assigns Manning's n coefficients to each cell,
and assigns boundary conditions to the grid, as directed by the FVHM program. Boundary
conditions are typically assigned as incoming flow rates at one end of the grid and exit
water elevations at the opposite end of the grid. Boundary point coordinates are saved in
a data file. There may be many boundary points in a complex study site like a salt marsh.

D. RUNNING THE FVHM

All hydrodynamic solutions are calculated by the FVHM program. The start, progress, and
termination of the calculation are managed in the Main Window. The results are output to
a Results file in binary format.

E. POST-PROCESSING THE SOLUTION DATA

After you have run the FVHM program, the results are post-processed by FVHM. The
progam can display time-step animations of velocity vector plots, color-coded contour lines
of water elevations, and Froude number distributions. The animations may be replayed.
Results from selected cells in the Result file may also be copied to an ASCII file for display
or other uses.

E THE FVHM WINDOW

Read this section carefully before you begin to work with the FVHM program, for it is
necessary that you have an overall understanding of the basic processes, functions, and
tools provided. IN OTHER WORDS, READ THIS USER’S MANUAL FIRST!

Go to the directory in which you installed the FVHM package from the Systems Diskette.
Double-click the ESTU.EXE program icon to open the FVHM Window as shown in Fig. 2.1.

The FVHM window is a graphical user interface. It gives you a simple and intuitive
environment for creating complicated finite-volume grids, running the program, and for
post-processing. The screen is divided into four sections, as shown in Figure 2. 1. You can
access On-line Help by clicking the tool bar or Help menu.
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Fig. 2.1. The FVHM Screen, showing a computational domain and the grid cells, density-
coded for water depth during part of a tidal cycle (see also Fig. 1. 1).

At the top of the Main Window, the Menu Bar is used to access FVHM commands; the
Toolbar allows you to access commands quickly; the Workspace displays the current grid;
and the Status Bar displays help messages and other information. Each of these will be
discussed in detail below.

a. Model Main Window. The Model Main Window is the most important part of
your interface. It displays all of the actions you take as you work with FVHM.

b. The Menu Bar. The menu bar consists of eight menus: File, Edit, Search, View,
Project, Result, Tool, and Help, used to access all of the FVHM commands. Commands
are accessed through pull-down menus located in the menu bar. Each menu can be
accessed using the mouse or by holding down the ALT key and pressing the respective
highlighted letter shown in the Menu Bar. Once amenu s visible, the individual command
can be chosen with the mouse or by holding down the ALT key and pressing the
highlighted command letter in the Menu.



THE FILE MENU
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Fig. 2. 2. The File Menu.

The File menu provides commands for creating a new project, opening an existing project,
saving a project, printing, and exiting the application. See Fig. 2.2.

File | New Command.

The File | New command is used to create a new project and to activate the graphics
window. After this command is selected, a dialog box will be brought up asking for a file
name for the new project (see Fig. 2. 3). Project file names in this model have the extension
.est. Thisis an ASCII file, designed to contain all the input data (grid information, boundary
conditions, etc.), for FVHM. This command must be selected each time a new modeling
project is started. The initial FVHM main window is empty; but, you may start to create a
new grid right away, once the new project has been created.
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Fig. 2. 3. File Open Dialog Box.
File | Open Command.

The File | Open command opens a file dialog box like that shown in Fig. 2. 3, so that the
user may browse the directory and select an existing project to load into the project work
space. This command should be selected before the user begins editing a project grid or
boundary conditions, or running the model.

File | Save Command.

The File | Save command is used to save the current active project to the same file from
which it was loaded or created in the Save As dialog shown in Fig. 2 .4. The pro]ect file thus
saved will have the file extension .est.

File | Save As Command.

The File | Save As command allows the user to save the current project under a new
name, or in a new disk location. The command displays the Save File As dialog box (see
Fig. 2. 4). You may enter the new file name if you wish, including the drive and directory.
If you choose an existing project name, you will be asked if you want to overwrite the



existing project.

wbsmall.est

File name: (TSSO

Save

 Savesstype: [Est2D Files [“est) ~]  Cancel

Fig. 2. 4. Save As Dialog Box.
File | Print Command.

The File | Print command prints the project grid under the current project settings. Use
File | Print Preview to see how the grid will be laid out in the printer output. Use File |
Print Setup to select a printer and to set printer options.

File Print Preview Command.

The File | Print Preview command opens a special window showing how the project grid
will look when it is printed.

File | Print Setup Command.

The File | Print Setup command displays the Printer Setup dialog box (see Fig. 2. 5),
which allows you to select and configure the printer in the usual manner.
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Fig. 2. 5. Print Setup Dialog Box.
File | Import Command.

The File | Import command allows you to import from ASCII files. There are two types of
ASCII import files currently supported. First, outline data files contain sets of x, y, z
coordinate data—the locations and bottom elevations of surveyed pointsin your study site.
Second, previously exported project files in ASCII are also supported, such as result files,
which are needed to restart the calculation. Outline data files have the extension .oln, and
ASCI project files have the extension .prj.

File | Export Command.

The File | Export command allows you to export data from a binary file into an ASCII file.
The exported ASCII project file can be edited directly, and imported back into the model.

File | Exit Command.
The File | Exit command exits the program. You will be prompted to save your project

10



before exiting. This command may also be accessed by pressing ALT + F4.

Fig. 2. 6. The Edit Menu.

EDIT MENU

There are fifteen commands under the Edit menu (see Fig. 2. 6). These commands are used
to edit the grid of the active project.

Edit | Undo Command (not implemented).

The Edit | Undo command restores the project to the way it was before your last edit
operation. This command is not implemented at present.

Edit | Select Command.

The Edit | Select command allows you to select a group of cells. The numbers of the cells
selected will also be highlighted (the Display Cell Number setting must be selected before
you can see the highlighting). Once the cells have been selected they are ready for

11



commands such as Copy, Delete, and Edit Grid, etc.
Edit | Cut Command (not implemented).

The Edit | Cut command removes the selected cells from their current locations and places
them in the memory buffer. You may later paste them to some other location within the
project grid. This command is not implemented at present.

Edit | Copy Command.

The Edit | Copy command leaves the selected cells intact and places an exact copy of them
in the memory buffer. You may later paste these cells to some other location within the
project grid as necessary.

Edit | Paste Command.

The Edit | Paste command will take the cells in the memory buffer (put there by either the
Edit Cut command or the Edit Copy command) and paste them into the project grid. After
selecting the cells to paste, an outline of the cells in the buffer will be displayed under the
mouse cursor. The next time you click the left mouse button inside the project work space,
the cells will be pasted at the location of the mouse pointer.

Edit | Delete Command.

The Edit | Delete command deletes the currently selected cells from the project. This
command is equivalent to hitting the Delete key.

Edit | New Cell Command.

The Edit | New Cell command is used to create new cells one at a time. After this
command is selected, left-click the cursor wherever you desire to create new nodes and
new walls. Complete the new cell by closing its perimeter: click back on the first node, and
anew cell will be created. During th e process, nodes and walls are generated automatically
by FVHM. The Edit |[New Cell command may also be accessed by clicking on the Tool
icon or by pressing ALT + C.

12



Edit | Grid Command.

The Edit | Grid command will bring up the Cell Property dialog (see Fig. 2. 7). In this
dialog you may choose a cell with the < or > key, and you may modify the properties of
that cell, e. g., its initial water elevation, its bottom elevation, its velocity components in the
x and y directions, and its Manning's coefficient. This command can also be accessed by
pressing ALT + G.

84463

000000

Fig. 2. 7. Cell Property Dialog Box.

If you use Edit | Select to select one cell or a group of cells first, and then use the Edit |
Grid command, the dialog box will look like that shown in Fig. 2. 8, below:

13



Fig. 2.8 Cell Property Edit Dialog Box.
Edit | Boundary Section Command.

The Edit | Boundary Section command brings up the Boundary Section Edit dialog (see
Fig. 2. 9).

i B oundaw‘ Svectios

Fig. 2. 9. Boundary Section Edit Dialog Box.
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The Boundary Section Edit Dialog allows you to group all of the boundary walls into
sections, and to specify the type of boundary condition at each section. Details of assigning
boundary conditions are given below in Section 5. This command can also be accessed by
pressing ALT + B.

Edit | Move Node Command.

The Edit | Move Node command sets the model into the Move Node mode, and allows
you to move an existing node from one location to another. By this means, you may adjust
the shapes of those cells and walls that share a node. Selecting Edit | Move Node again will
exit the Move Node mode.

Edit | Split Wall Command.

The Edit | Split Wall command sets the model into Split Wall mode, allowing you to insert
nodes in a wall. Click Edit | Split Wall again to exit the Split Wall mode.

Edit | Split Cell Command.

The Edit | Split Cell command allows you to split a cell by connecting two nodes off a cell
wall. After choosing the command, you may click on the node where you want to split the
cell, and then click another node of the cell to split it. You may also click inside the cell

somewhere between the first click that starts the split and the last click that ends the split,
to form a more complex split path.

Edit | Merge Cells Command.
The Edit | Merge Cells command allows you to merge selected cells.
Edit | Remove Node Command.

The Edit | Remove Node command is used to remove an unnecessary node from the grid
so a user may adjust the shape of a cell.

15
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Fig. 2. 10. View Menu.
VIEW MENU

The View menu provides commands for what will be shown in the project work space, and
how those features will be displayed (see Fig. 2. 10).

View | Toolbar Command.
The View | Toolbar command is used to display or hide the toolbar menu.

View | Status Bar Command.

The View | Status Bar command is used to display or hide the Status Bar.

16



View | Split Command.

The View | Split command is used to split the application workspace into multiple view
ports.

View | Grid Command.

The View | Grid Command is used to display the project grid system. This command can
also be accessed quickly from the Toolbar icon. All of the icons and their respective
functions are described under the Toolbar section below).

View | Bottom Command.

The View | Bottom command is used to display bottom elevations in gray-scale levels
within the modeling domain. This command can quickly accessed from the Toolbar.

View | Depth Command.

The View | Depth command is used to display water depth distributions in blue-scale
levels within the modeling domain. This command may be accessed quickly from the
Toolbar.

View | Water Surface Command.

The View | Water Surface command is used to display water surface elevations in blue-
scale levels within the modeling domain. It may also be accessed from the Toolbar.

View | Velocity Vector Command.

The View | Velocity Vector command is used to display velocity distributions with arrows
in the modeling domain. It is also accessible from the Toolbar.

View | Froude Number Distribution Command.

The View | Froude Number Distribution command is used to show regions of supercritical

17



flow in red, and regions of subcritical flow in blue. It is also accessible from the Toolbar .

View | Zoom In Command.

The View | Zoom In command is used to magnify the viewing area. This command is also
accessible from the Toolbar icon.

View | Zoom Out Command.

The View | Zoom Out command is used to shrink the viewing area. This command is also
accessible from the Toolbar.

View | Vector Longer Command.

The View | Vector Longer command is used to magnify the velocity vectors. This
command is also accessible form the Toolbar.

View | Vector Shorter Command.

The View | Vector Shorter command is used to decrease the size of the velocity vectors.
This command is also accessed from the Toolbar.

View |Toggle Animation Command.

Choosing the View | Toggle Animation menu command will stop the model from
redrawing the workspace at every time-step the during the simulation run. This will speed
up the simulation process. The command is only available while a simulation is running.

View | Toggle Link Command.

Choosing the View | Toggle Link menu command places the project workspacein a special
mode under which the lines and square dots representing the imported outlines can be
toggled on and off by clicking on them with the left mouse button. This command is useful
when you are importing a model outline.
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View |Toggle Zoom Link Command.

Choosing the View | Toggle Zoom Link menu command places the model in Quick Zoom
mode. In this mode, left-clicking the mouse while the cursor is inside the workspace will
zoom in, and right-clicking will zoom out.

:FarmRiver.e

Figure 2. 11. Project Menu Commands.
PROJECT MENU
The Project menu includes the commands for operating FVHM.
Project | Run Command.

The Project | Run command is used to run the FVHM program. Once the grid has been
constructed (including its Manning’s n coefficients and initial conditions) and boundary
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conditions have been assigned, one may use this command to start the simulation of the
hydrodynamic process.

When the Project | Run command is selected, a Modeling Options dialog box appears (see
Fig.2.11) to allow you to set the beginning date and time, ending date and time, animation,
view content (either water elevation, water depth, velocity, or Froude number), and output
time intervals. The Project | Run command can also be accessed by pressing F5.

|Modeling Options

Fig. 2. 12. Modeling Options Dialog Box.
Project | Pause Command.

The Project | Pause command is used to pause the simulation in progress. This command
can also be accessed by pressing Fé.
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Project | Stop Command.

The Project | Stop command is used to stop running the simulation. This command can
also be accessed by pressing F7.

Fig. 2. 13. Project Option Dialog Box.

Project | Options Command.

The Project | Options command is used to set the basic parameters of the modeling project.
Once you selects this command, a Project Options dialog box will pop up (see Fig. 2. 12).
You may choose the engineering units, project domain size, screen coordinates, drawing
content, and the way cells are drawn.

This command should be used to determine the domain size to be modeled before
importing the project outline; it is often used during both editing and post-processing
procedures. This command can also be accessed by pressing F8.
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Figure 2.14. Result Menu Commands.
RESULT MENU
The Result menu provides two ways for you to handle calculation results.
Result | Play Command.

The Result | Play command is used to display the animated hydrodynamic process
calculated by a previous simulation.

Result | Time History | Export Command.

The Result | Time History | Export command is used to output calculated results for a set
of selected cells to an ASCII file (with extension .tmh) so that you can process the data for
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other applications. Before selecting this command, you should first select the cells of
interest by using the Edit | Select menu. Then, go to the Result menu and select Time
History | Export. After Result | Time History | Export has been selected, a Save As dialog
box will pop up (see Fig. 2. 13), asking for the filename and address of the file to be saved.

Fig. 2. 15. Tools Menu command.

ime History Data Files [*.tmh)

Fig. 2.16. Save As dialog box.
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TOOLS MENU
Tools | Linear Interpolate Command.

The Tools | Linear Interpolate command is used to interpolate specific cells state values
among two or more selected cells. You must first select a set of cells such that the first and
last cells selected contain the values to be interpolated. After selecting those cells and
choosing a command, a dialog will pop up, asking which state values of the cells are to be
interpolated. When you click on OK to close the dialog, the selected state values of the first
and last cells you chose will be linearly interpolated onto the other cells you selected, based
on the order in which you chose them and the distance between the first and last cells.

HELP MENU (UNDER CONSTRUCTION).

a. Toolbar. The Toolbar is a row of buttons at the top of the main window. Each of
these buttons controls an application command. Clicking one of the buttons is a quicker
alternative to choosing a command from the menu. Depending on the application or
command selected, the buttons toggle the commands on and off. The buttons, with their
actions and menu equivalents, are listed and shown below.

Button Action Menu

Create a new project File|New
Locate and open a project File| Open
Save the file in the active window File|Save
Cut selected cells to Clipboard Edit|Cut
Copy selected cells to Clipboard Edit| Copy
Paste from Clipboard Edit| Paste
Print the active window File| Print
Initiate model simulation Project|Run
Replay simulation result Result|Play



Pause model simulation or replay
Stop model simulation or replay
Edit model grid

Enable or disable zoom mode

Zoom in for detailed grid structure
Zoom out to view whole grid system

Show longer vectors of velocity field

Project | Pause
Project|Stop
Edit | Grid

View | Toggle
Zoom

View | Zoom In
View | Zoom Out

View | Vector

- Longer

Show shorter vectors of velocity field ~ View | Vector

Shorter
Show Grid Walls Help | Contents
Show water surface elevation Help | Contents
Show water depth Help | Contents
Show bottom elevation Help | Contents
Show velocity vector Help | Contents

Show Froude number Help | Contents

Display help file contents Help | Contents

b. Status Bar. The Status Bar at the bottom of the screen displays helpful messages
or information regarding the current operation on the left. On the left of the Status Bar is
a message area. After the mouse cursor rests on a tool icon for a short time, a description
of the icon will appear in this window during calculation. The first box to the left of this one
displays the maximum iteration error, and the next box indicates the present time. When
the cursor is moved within the Workspace, the x, y coordinates of the cursor are displayed
in a third box. Its physical coordinates (x, y, z) in the model domain and the selected
variable (e. g. water surface elevation) will be shown in the fourth box. The box at the
extreme right shows the zoom ratio (see also Fig. 1. 1).
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III. FILE INPUTS AND OUTPUTS
A. THE PROJECT FILE

The Project file is an internal file which contains data that has been input to the model, and
(or) that has been generated by the model. Itis in binary format, and has the extension .est.
The data could be interdependent; therefore you should not attempt to edit the file. For
example, if the coordinates x, y, of a pointin the model are changed or eliminated, the sides
of the cell connected to this point (node) and the physical properties of the cell of which the
node is a part will be changed as calculated by the model.

B. IMPORT AND EXPORT FILES

Import and Export files are in ASCII format, and have the extension .prj. All of the project-
related data, such as grid information, initial conditions, boundary conditions, etc. in the
Project file can be exported as an ASCII file. This file can be imported later if needed.
Although Import and Export files can be edited with the Text Editor, we do not recommend
that beginners directly edit the Project file with it. On the other hand, experienced users
may find that editing the Import and Export files directly can save time and energy. But
before you start editing, always remember to back up your data, and to back up the program files!

The following is an example of a very simple import and export project file:
Example: entry nos. in Line 1.
1 2 3 4 5 6-10

Line

1 5 70.2814539930551 -13.3416015624998 639.040000000001 479.28000000000111110

110 355.0347222 -183.1597222
121 422.7430556 -183.1597222
151

1996 10 26 5 37 59 -0.118872
1996 10 26 6 6 23 -0.100584
1996 10 26 6 34 47 -0.04572
1996 10 26 7 3 11 0.04572

1996 10 26 7 31 35 0.161544

O 0 N1 O U e W
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10 1 4 0 422.743055555555 -246.527777777778

11 160 353.298611111111 -246.527777777778

12 231 1.57079632678995 67.7083334129 0

13 251 6.28318530646337 63.3680555777777 249 0

14 271 4.71238898036984 69.4444444444444 4690

15 2 81 3.11420224547 63.39183346000726 19 0

16 391 10.1 388.454861116667 -214.843749988889 4345.55242454668 5.2 -0.130.05000.02543 57 8
17 422

18 7

19 8

20 412
21 3

22 5

23 62

24 381.94-198.7851
25 401.91-197.054.91

Line 1

The first number is a definition number. In this case, “5” means “this line is about model
settings.”

The second and third numbers are the x and y coordinates of the upper left corner of the
application work space.

The fourth and fifth numbers are the x and y dimensions of the application workspace.
The sixth number codes for engineering units (0 = English; 1 = Metric).

The seventh number indicates whether nodes will show on the screen (1 = showny; 0 = not
shown).

The eighth number indicates whether walls will show on the screen (1 = shown; 0 = not
shown).

The ninth number indicates whether cells will show on the screen (1 = shown; 0 = not
shown).

The tenth number indicates how the cell is to be shown on the screen (0 = cell number; 1
= head distribution; 2 = velocity vector; 3 = Froude number; 4 = bottom elevation; 5 =
water depth).
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Line 2 to End

Beginning with line 2, the first number of each line defines the content of that line, as
follows:

Line 2. Node data. The second number is the node number; the third number indicates
whether there is attached observation data for this node (0 = no data is attached for this
node; 1 = data attached for this node). The fourth and fifth numbers are the x and y
coordinates of the node. If there is attached observation data for the node, then the next
line will begin an observation data section (for details on the format of observation data
sections, see the section on the Observation Data File).

Line 3. Wall data. The second number is the wall number; the third number indicates
whether this wall is a boundary wall (0 = boundary wall; 1 = not a boundary wall); the
fourth number is the wall angle with respect to the axis; the fifth number is the wall length;
the sixth number is the beginning node number; the seventh number is the ending node
number; the eighth number is the left side cell number; and the ninth number is the right
side cell number. If the wall is a boundary wall, there may not be a left or right side to the
cell, and in that case the eighth number or ninth number should be set to zero.

Line 3. Cell data. The second number indicates whether the cell is a structure or non-
structure cell (0 = non-structure; 1 = structure); the third number is the cell number; the
fourth number indicates whether the cells is a boundary cell (0 = non-boundary cell; 1 =
boundary cell); the fifth number is the water elevation; the sixth and seventh numbers are
the x and y coordinates of the center; the eighth number is the cell area; the ninth number
is the cell bottom elevation; the tenth and eleventh numbers are the initial velocities in the
x and y directions respectively; the twelfth and thirteenth numbers are the bottom surface
slopes in the x and y directions respectively; the fourteenth number is Manning's
coefficient, n; and the fifteenth number is the number of walls surrounding this cell; the
following numbers are the wall serial numbers.

Line 5. Boundary section description line. The second number indicates the boundary type
condition for the section; the third number (say, 1) indicates how many walls this boundary
section contains. The next n lines are the serial numbers of the walls making up this
boundary section.
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Line 6. Outline section description line. The second number indicates how many points are
contained in the outline data. The next n lines (here, 4) will be the x, y, z coordinates for
each outline point plus a flag digit indicates whether or not the point is linked with other
outline points. ‘

C. OUTLINE FILES

An Outline file records a set of locations inside the modeling domain, where the bottom
clevations are known. The elevations are normally obtained by field survey. The outline
file has a .oln file extension, and should be prepared by a text editor before it is imported
into the Outline file. The Qutline file format is of three columns x, y, z, separated by blank
spaces. The following is an example:

661904.154 1075664.550 2.160
662304.019 1073868.730 1.540
662757.129 1075789.082 1.660
663208.396 1075862.093 2.990
662528.066 1074158.698 2.930
663118.208 1075617.905 3.130

Units acceptable for x, y, z are either decimal feet or meters. Before each import, you should
make sure that the system of units used in the project file is the same as that in the outline
file.

D. BOUNDARY CONDITION FILES (OBSERVATION DATA FILES)

An observation data file (Boundary Condition File) contains data normally observedin the
field as tide staff readings and current measurements. These observation data are associated
with nodes within the model grid. When a node is located on the border, the data
associated with that node normally becomes a boundary condition. The Boundary
Condition File normally has a .bdc file extension, and has the following format:

1100

1996 10 26 537 59 -0.39
19961026 6 623-0.33
1996 1026 63447 -0.15
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1996 1026 7 3110.15
1996 10 26 7 31 35 0.53
1996 10 26 759 59 0.99
19961026 828231.48
1996 10 26 8 56 47 1.98
1996 10 26 92511 2.46
1996 10 26 9 53 35 2.88

Line 1: The first number is the boundary condition type. In the example shown, 1 means
the first type of boundary condition (water elevation boundary); a 2in this position means
the second type of boundary (flow boundary). The second number is the number of entries
in the file ( how many sets of observation data; here, 10); and the third number represents
the engineering unit system (0 = English, decimal, 1 = metric).

Line 2 to end: Each subsequent line represents a set of observation data. The first number
is the year, the second number is the month, the third number is the day of the month, the
fourth number is the hour (in 24 hr. format), the fifth number is minutes, the sixth number
is seconds, and the seventh number is the observed value at that time. (It may seem
awkward to have the year, month, etc. in every line, but it is more easily read and managed
by the program). :

E. RESULT FILE

The Result file records the modeling results at fixed time intervals throughout the entire
simulation time span. At each cell, center location, water elevation, and current velocity in
the x and y directions are recorded.

The Result file is a binary file and it has to match the Project file. Therefore if the Project
file is changed, the Result file must also be changed to match it. The Result file has the file
extension .run, where nn (00, 01, etc.) may represent increments in the simulations at
different times.

30



E. ExPORTED TIME HISTORY FILES

Calculation results for the cells under study in the Result files can be output to an ASCIl file
so that you may edit them in a number of ways.

The Exported Time History file has the file extension .tmh. The following is an example of
one of these files:

Head 3862

0 0.878803
300 0.871205
600 0.860556
900 0.856184
1200 0.860379
1500 0.868827
0.876505

U 3862

0 -0.0316636
300 -0.0757137
600 -0.118039
900 -0.108686
1200 -0.0642724
1500 -0.00458682
1800 0.0662282
V 3862

0 0.0626617
300 0.115999
600 0.175231
900 0.163989
1200 0.0986731
1500 0.00539711
1800 -0.1029
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In this example, the number 3862 is the serial number of the cell selected. In the first block
of numbers above, columns one through six contain the time (in seconds), and the
following columns are the calculated water elevation at the centers of the cells. The second
block is the calculated results for the velocity component in the x direction, and the third
block contains the calculated results for the velocity component in the y direction, on the
common boundary of these two cells.
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IV. CONSTRUCTING THE MODEL GRID

A computational grid is here defined as a network of cells constructed from connected
nodes and assigned walls. The grid should be so constructed that it represents the essential
features of the domain to be modeled. FVHM provides you with a number of tools for grid
construction and editing.

A. CREATING A NEW PROJECT
1. The first thing you do is to create a New Project for the site to be modeled.

2. To open the FVHM Main Window, double click the ESTU.EXE program icon from the
directory where you installed the FVHM software package. The initial workspace screen
is empty, and your project has the default name Untitled.

3. Go to File Menu, select the File | Save As command, and a File Save As dialog box like
that shown in Fig. 4. 1 will appear.

Riemann.est
wbsmall.est

Estu2D-Files [*.est]

Fig. 4. 1. Save As Dialog Box.

4. Choose the directory and file name for the project (for example, new.est). Remember that
the project file name must use .est as its extension. Then dlick the OK button, and abox will
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pop up to confirm that you wish to create the new file.
B. PROJECT OPTIONS

1. Click the OK button in the confirmation box that appeared under step 4 above, and a
Project |Options dialog box pops up (see Fig. 4. 2.). From this box you can define the
engineering units to be used, the project domain size, what to draw on the screen, and how
to draw the cells.

Fig. 4. 2. Project Options Dialog Box.

2. Click the OK button after selecting your options. Now you are ready to construct the
grid. (Already existing projects may be opened now by using the File | Open command.)

C. IMPORTING THE OUTLINE

Before creating or editing the grid, the outline of the site to be modeled (for example, from
survey data, existing maps, aerial photographs, or orthophotographs) may be imported to
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the main graphics window. This outline file has the extension .oln, and may consist of a set
of points with x, y, z coordinates, and can be displayed in the background as a guide for
creating or editing cells, nodes, and walls. To import an outline:

Outline Files (*.olr)

Fig. 4. 3. Open Dialog Box.

1. Select File | Import | Outline, and an Open Dialog box will be brought up (see Fig. 4.
3).

2. In the Drives box, choose the drive in which the project directory was created.
3. In the Folders box, locate and open the project directory.

4. In the File Name box, find and highlight the outline file, and click the OK button.
This will import the outline data points to the FVHM main window.

D. CREATING A NEw CELL

A new cell can be created by the following procedure:
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Fig. 4. 4. Context Menu.

1. Select Edit | New Cell, or right-click inside the project work space. A Context Menu will
pop up under the mouse cursor (see Fig. 4. 4). Select New Cell.

2. Move the cursor to a starting point in this workspace and left-click the mouse. A new
node will be created. This is the first node.

3. Next, move the mouse to another location inside the project work space, and left- click
again to create the second node. The program will automatically create a new wall.

4. Repeating this process will create a series of walls. Once you close a path by clicking back
on its first node, a new cell will be created and the process ends (see Fig. 4. 5).
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nmlw; Estuzw i

Fig. 4. 5. Creating New Cells.
5. Repeat the above four steps to create additional cells as desired.
E. SELECT CELL(S)
The Select command is used to select cells that user wants to copy, delete, edit, or merge.
To select cells:
1. Click the Edit | Select command, or press Ctrl + M. FVHM is now in Select mode.
2. Click on any cells you wish to select. The numbers of the cells will be highlighted.

3. To select a contiguous group of cells, click and hold the left mouse button, then drag a
rectangle around the group of cells.

4. Click again on an already highlighted cell to deselect it.
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After the selected cells have been edited, deleted, copied, or merged, FVHM will exit the
Select mode automatically.

E CoPY AND PASTE CELL(S)

The Copy and Paste commands can save you a great deal of time in constructing cells. To
copy a cell or a group of cells,

1. Click the Edit | Select command.

2. Click on the cell(s) you want to copy.

3. Click the Edit | Copy command. The cell(s) has now been copied into a memory buffer.
4. Click the Edit | Paste command. The copied cell(s) appear highlighted at the cursor.

5. Move the cursor to where you want to paste the cells, and left-click the mouse. The Paste
procedure is now completed.

G. DELETE CELL(S)

To delete a cell or a group of cells,

1. Click the Edit | Select command.

2. Click on the cell(s) you want to delete.

3. Click the Edit | Delete command. The cell(s) have now been deleted.
H. MERGE CELL(S)

1. Click on the Edit | Select command.

2. Click on the cell(s) you want to merge.
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3. Click on the Edit | Merge Cells command. The cells will be merged if the model permits
it. Not all cells can be merged, because, for example, a cell representing a man-made
structure (“structure cell”) cannot be merged with normal cells.

I. MOVE NODE
If a cell is poorly shaped, you can adjust it by moving its nodes. To move a node:

1. Click the Edit | Move Node command. FVHM is now in Move Node mode, and only
the Move Node command shows on the Edit menu.

2. Move the cursor to the node you want to adjust.

3. Click and hold the left mouse button, and move the cursor to a new location.

4. Release the left mouse button. The node has now been repositioned.

5. Click the Edit | Move Node command again and FVHM will exit the Move Node mode.
J. REMOVE NODE

You can also adjust a the shape of a cell shape by removing one or more nodes, as follows.

1. Click the Edit | Remove Node command. FVHM is in Remove Node mode, and only the
Remove Node command shows in the Edit menu.

2. Move the cursor to the node you want to remove.
3. Click the left mouse button, and the node will be removed.

4. Click the Edit | Remove Node command again and FVHM will exit the Remove Node
mode.

Note: Once a cell becomes a triangle none of its three nodes may be removed.
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K. SAVING THE DATA

Once the grid has been constructed and edited, it should be saved to the Project File. To
do this simply click the File | Save command. A box will be brought up indicating that the
grid has been saved successfully (see Fig. 4. 6). Click OK to return to the main window.

Estu2D-Files:[*.est)

Fig. 4. 6.Save Project File.

We recommend that you save the grid once in a while during the process of grid
construction and editing, especially if the grid is large.
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V. ASSIGNMENT OF BASIC PARAMETERS AND BOUNDARY
CONDITIONS

Once a grid has been constructed and saved, FVHM automatically defines and numbers
both boundary and interior nodes, walls, and cells. What you need to do next is:

1. Assign initial conditions, bottom elevations, and Manning’s n coefficients to each of the
cells; and,

2. Assign boundary conditions.
A. ASSIGNING BASIC PARAMETERS

The basic parameters of a grid are initial conditions, bottom elevations, and Manning's
roughness coefficients. To assign these basic parameters to a cell,

1. move the cursor to the cell first, then right-click the mouse and choose the Edit Grid

command, or click Edit | Grid in the menu, or click the Toolbar icon 8. A Cell Property
dialog box will be brought up (see Fig. 5. 1).

2. The Cell Property Dialog allows you to assign or modify the properties of each
individual cell (in Fig. 5. 1, the individual cell is cell no. 23), such as the initial water
elevation of the cell, the bottom elevation of the cell, the velocity in x and y directions and
the Manning's coefficient, n.
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Fig. 5. 1. Cell Property Dialog Box.

In the dialog box, the center coordinates are the averages of all the nodal coordinates of the
cell. Slope of a cell bottom is calculated by comparing it with the bottoms of neighboring
cells.

3. The Walls panel on the right lists all the walls belonging to this cell. By selecting one of
the walls and clicking the Edit Wall button, the Wall Property dialog for that wall will be
brought up, allowing you to examine the properties of that wall. The panel tells you if the
cell is a boundary cell. You may use the < and > keys to browse through all the cells in the

grid.

It may be convenient (and it decreases run time) if you assign the same parameters to a
group of cells using the Group Edit dialog:

1. Click the Edit | Select command.

2. Select a group of cells with the same basic features.
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3. Click the right mouse button and choose the Edit Grid command to bring up the Cell
Property Edit dialog box (see Fig. 5. 2).

4. Choose and input the parameters, then click OK.

Fig. 5. 2. Cell Property Edit Dialog Box.
B. ASSIGNING BOUNDARY CONDITIONS

Normally, the model boundaries consist of the land boundary, the water boundary, and
the flow—no flow boundary. Specifying boundary sections and boundary types is a critical
step in the use of this model. You must specify boundary sections, and associate boundary
condition types with each section unless the project has no flow boundary conditions that
apply uniformly to all the of boundaries. The no-flow condition is the default if boundary
sections are not specified. In FVHM, there are three types of boundary conditions: Type 1.
water surface elevation; Type 2. no flow; and, Type 3. flow or velocity. Assigning boundary
conditions consists of two operations:

a. Specifying boundary sections and boundary types;
b. Assigning observed data to boundary nodes.

You may specify boundary sections and boundary types via the following steps:
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1. Click the Project | Options command to bring up the Project Options dialog box (see
Fig. 5. 3).

Fig. 5. 3. Project Options Dialog Box

2. From Draw options, select Wall, then click OK. This shows the project as it will appear
within the walls. The walls will be highlighted when they are selected in the Boundary
Section Edit dialog.

3. Click the Edit | Boundary Sections command to bring up the Boundary Sections Edit
dialog box (see Fig. 5. 4). The box on the left lists all the walls at the border. In the list-box,
the first column is boundary wall number, the second column is boundary section number,
and the third column is the boundary type. The Boundary Section Edit dialog allows you
to group all of the boundary walls into sections, and to specify the type of boundary
condition at each section.
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Fig. 5. 4. Boundary Sections Edit Dialog Box.

4. Select a group of walls from the Boundary Walls list-box either by Shift+click or
Ctrl+Left-click. The walls will be highlighted in the project workspace as they are selected.

5. Click the>> button in the middle of the Boundary Section Edit dialog box. The selected
walls will be listed in the list-box on the right. You may select more walls from the left and
add them to the right or select them from the right and use the < < button toremove them.
Keep in mind that you should keep the walls selected in the right list-box within a
consecutive boundary section, and highlighted sections in the workspace should be one
contiguous unit.

6. Assign a section number in the Section box, and specify the boundary condition type
for this section. Remember, Type 1 is the water surface elevation boundary, Type 2 is the
land boundary (the no-flow boundary), and Type 3 is the flow boundary, through which
the flow rate is controlled by a given formula.
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7. Click the Set button, and the right Section Walls list-box will be cleared. The section
number and boundary condition type number will be listed along with the wall number in
the left Boundary Walls list-box.

8. By repeating steps 4 through 7, you can specify multiple boundary sections, and assign
different boundary condition types to those sections.

9. After specifying the boundary sections and boundary types, click the OK button. The
program will then perform a check on the sections. The following errors may occur if the
boundaries are not correctly specified:

a. walls in a section may not be continuous; and(or),

b. the boundary condition type may not match the observed data already attached
to one or more nodes in a section.

If no error is found, the program will keep the the section information, and save it when
you save the project. The section information will be cleared if any boundary walls were
removed as a result of Cell Delete and Cell Merge. If that happens you has to go through
the Boundary Section Edit Dialog again.

C. OBSERVED DATA

After specifying the boundary sections and boundary types, you should assign the
observed data to the boundary nodes. Commonly, observed data are available for only a
few nodes or for just a single node, for a boundary section. In such cases, fro example,
where data could be the diurnal variation of tidal stage, or a flow hydrograph at an
upstream boundary, FVHM automatically interpolates between nodes.

Here are the steps you follow to assign observed data to boundary nodes:

1. Prepare the observed data file (boundary condition file) in the format described in
Section ITI, and save the file into the project directory. The observed data file must have the
extension .bdc.

2. Move the cursor to the boundary cell with the observed data, and then click the right
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mouse button and select the Edit Grid command. A Cell Property Dialog is brought up

(see Fig. 5. 1).
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ig. 5. 6. Node Property Dialog Box.
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5. From the Node Property dialog, you may specify a new x and y location for the node.
The node will be moved to a new location, the length of the wall the node is attached to
will be recalculated, and the area of the cell the node belongs to will also be adjusted.

6. The < and > buttons will allow you to browse through all the nodes in the project. Use
these to browse the boundary nodes. Selected nodes will be highlighted. Find the node
with the observed data, and click the Observed Data button. This will bring up a File |
Open dialog box, which allows you to attach a string of observed data to the node (see Fig.
5.7).

Observed Data Files {*.bdg)

Fig. 5. 7. Open Observed Data File.
7.Select the observed data (that were input earlier to a Boundary Condition File, described
in Section 1II), and click the OK button. The observed data will be assigned to the node
automatically.
8. Repeat steps 1 through 4 for all other boundary nodes for which observed data are
available.

D. SAVING THE PROJECT

After assigning basic parameters and boundary conditions, don’t forget to Save the project.
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VI. RUNNING THE MODEL

Once you have finished building the grid and assigning basic parameters and boundary
conditions to it, the project file— which includes all of the data necessary to run the model
—has been generated. Now you are ready to have FVHM simulate the dynamic process.
To run FVHM:

1. Click the Project | Run command to bring up the Modeling Options dialog box (see Fig.
6. 1). This dialog allows you to specify the parameters of how the simulation will run.

Fig. 6. 1. Modeling Options Dialog Box.

2. Select Start Date and Start Time for the simulation. You may start the simulation at any
time after the last boundary condition starting time.
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3. Select the End Date and End Time for the calculation. You may end the calculation
anywhere inside the boundary (the end date and time must not be earlier than the start
date and time). '

4. Select the First Time Step, Maximum Iteration, and Maximum Error Allowance.

5. Select Animation if required. If animation is required, you can further choose the View
Content (Head, Velocity, or Froude Number.) Animation allows you to check the
computation dynamically, but it slows down the simulation.

6. Select the Output Time Interval.

7. Click OK to run the model. You can stop or pause the simulation anytime in between the
calculation by clicking the Project | Stop or Project | Pause command. The simulation can

be continued from the time you stopped or paused so long as you Save the previous
calculation results.
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VII. POST-PROCESSING

Theresults calculated by FVHM are saved in a single (binary) results file with the extension
.R00. FVHM provides two ways you to view this result file, described in this section.

A. RESULT PLAY

Just like showing a set of slides, Result Play shows the whole dynamic process of the
simulation in a series of plots. The time interval between plots is fixed, and was set in
Modeling Options (the Output Time Interval in Fig. 6. 1.) when you ran the model. You
can play the results for Water Depth, Water Elevation, Velocity, or Froude Number by
clicking the corresponding toolbar. The following steps are taken to view the simulation
process:

1. Click File | Open to open the Project File ( extension .est).

2. Click the View | Depth, View | Water Surface, View | Velocity Vector, or View |
Froude Number Distribution command to set up the view content. You may also do this
by clicking the corresponding toolbar.

3. Click Result | Play to play the result.

Note: At present the print function under FVHM s still under construction, so you cannot
print result plots directly. To output a plot however, your can use following procedure:

1. Click File | Open to open the Project File (extension .est).

2. Click the View | Depth, View | Water Surface, View | Velocity Vector, or View |
Froude Number Distribution command to set up the view content. You can also do this by
clicking the corresponding toolbar.

3. Click the Result | Play command to play the result.

4. Press the Pause/Break button as soon as he required plot appears in the FVHM main
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window. This stops Result Play temporarily, and the plot you want shows in the main
window.

5. Press Alt + Print Screen to copy the plot to your memory bulffer.

6. Open the Windows Paint program from your computer’s Accessories (see Fig. 7. 1).

: wbsmal ét - E#tu

Fig. 7. 1. Paint Screen.
7. Click Paint’s Edit | Paste command, and the plot you saved in the memory buffer will
be moved into the Paint window.
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8. Click Paint’s File | Print command to output the plot to your printer.
9. Repeat Step 2 through Step 8 to print all of the other plots you may want.
B. RESULT | TIME HISTORY | EXPORT

The Result file contains all of the solutions for each node in binary format, and is therefore
not conveniently handled by you. FVHM provides a way to output those results to an
ASCII file, so you can handle the Result data with other tools, such as Microsoft Excel. This
ASClI file is called the Time History File, and has the extension .tmh. The format of this file
was introduced in Section III. To output the results at certain nodes to an ASCII file, take
the following steps:

1. Click File | Open to open the Project File (extension .est).

2. Click the Edit | Select command and select the cell(s) for which you want to output the
calculation results. The Result | Time History | Expert mode is enabled only after the cell(s)
has been selected.

3. Click the Result | Time History | Expert command to output the results for the selected
cell (s). A Save As dialog will pop up, asking for a File Name and Folder (see Fig. 7. 2.).

ime History Data Files (*.tmh)

Fig. 7. 2. Save As Dialog Box.
4. Select the folder and input a file name; then click the OK button.
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VIII. FINAL REMARKS

In this version of FVHM, the finite-volume method for the solution of the shallow-water
hydrodynamics in a river—marsh system has been completed. The graphical user interface
in the Windows environment, including pre- and post-processing of input and output data,
graphical presentation of the results, and animation, is not considered fully completed,
however. We stress that FVHM will only be as useful as the input data is complete: that is,
if the regulatory process requires demonstration of final water surface elevations to a
particular tolerance, then the precision of field surveys and other data observations must
reflect that. We are continuing to implement, refine, and update various elements of this
model, and would appreciate any comments or feedback from users.

* * *
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